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About This Guide
This guide is intended to instruct a user in the use of the SmartType 3.0 application. It is assumed that the 
reader is familiar with karyotyping.

Please read before use

Keep these instructions in a safe place

Warning

SmartType provides automatic chromosome 
classification for assistance, but final 
classification and interpretation in relation to 
medical use is the responsibility of the qualified 
operator.

Conventions Used in this Guide
Menu items and dialog buttons appear in bold font e.g. “Press the OK button”
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SmartType Description
A karyotype is simply a picture of a person's chromosomes.  Creating a karyotype starts with selecting a 
cell at the metaphase stage of mitosis. The chromosomes are isolated, stained, and examined under the 
microscope. A picture of the metaphase cell containing the chromosomes is taken through the 
microscope.  Then, the picture of the chromosomes is cut up and rearranged by the chromosome’s size.   
The chromosomes are lined up from largest to smallest. A trained cytogeneticist can look for missing or 
extra pieces of chromosome.

SmartType is a software application for assisting in the preparation of karyotype images. It provides 
image editing tools for image enhancement, separating chromosomes from the background and each 
other, manual and automatic classification of chromosomes,  rotating and moving chromosomes onto a 
karyotype layout. recording patient and case details and tools for simple annotation.

SmartType takes as input pictures of metaphases stored as TIFF files. The karyotypes produced by 
SmartType are stored in a proprietary file format based on industry standard file formats and can also be 
exported as pictures stored in PNG format.
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Installation

Getting SmartType
The SmartType application, User Guide and example files are all available from the SmartType pages of 
our website at https://www.karyotyper.com

Computer System Requirements
SmartType may be installed on any Mac running Mac OS-X version 10.8 or greater, Any Windows 
computer running Windows 10 or 11, or any computer running Linux

We recommend that a minimum of 8GB memory.

We recommend a screen resolution of 2560 x 1440 (2K or 1440). A screen resolution of less can be used 
but things will seem a little cramped on the screen. Screens of 3840 x 2160 (4K) resolution and higher 
can be used but generally this is unnecessary and unless the screen is also physically larger than 27" 
because the screen pixels may be too small. Note however, often a 4K screen can be operated in a lower 
resolution so there is rarely a problem with these high resolution screens.

If you are going to store your karyotype files on your local computer, we recommend the use of a Solid 
State Hard Disk (SSHD) Typically for a laptop or desktop system this will need to be 512GB or 1TB.

SmartType can also store the karyotype files on a network file server.

Installing SmartType
SmartType 3.0 is supplied as a self contained application simply download the latest version of 
SmartType from https://www.karyotyper.com.

If you have not purchased SmartType you will only be able to run it in demonstration mode. This allows 
access to all the features but SmartType will time out after 20 minutes and you will not be able to save 
your karyotypes.
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When SmartType starts you will see the SmartType splash screen similar to:

SmartType Splash Screen

In the lower panel you will see some text that will include the serial number of your machine. After 
purchasing the full version of SmartType you need to copy all the text from this panel and email it to us at 
registration@dsuk.biz so we can enable your full version copy of SmartType.
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Quick Start Tutorial
This section gives you a step-by-step guide to using SmartType to karyotype a G band metaphase image. 
Example metaphase images are available from the SmartType pages of the Digital Scientific UK web site. 

Overview of Karyotyping with SmartType
Using SmartType to karyotype an image is achieved by a series of steps. These steps are:-

1. Create or open an existing SmartType case.

2. Import the metaphase image to be karyotyped.

3. Threshold the image to separate the foreground (chromosomes) from the background.

4. Optionally enhance the visual appearance of the metaphase image.

5. Manually edit the metaphase image to separate all of the chromosomes.

6. Create the karyotype by classifying the image using SmartTypes classifier.

7. Manually correct any errors to the karyotype classification.

Starting the SmartType Application
After downloading SmartType and installing it on your computer, launch SmartType by double clicking 
on the application. The SmartType application icon looks like this:

SmartType Application Icon
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After SmartType has displayed a splash screen, it will open the SmartType work window

SmartType Splash Screen

Creating a New Case
Select New Case… from the Case menu and enter a name for the new case: 

New Case Dialoge

Next you will be presented with the case information dialogue where you can enter the case information 

SmartType Case Information Dialogue

Click on Save to save the case information.

Select Show Options… from the Karyotype menu and fill in the Default Options dialog as shown 
below:
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Default Options Dialog

Importing the Metaphase Image
For the next step you are going to need an 8 bit monochrome TIFF image of a metaphase. If you have 
your own images ready you can use it otherwise you can download some example metaphase images 
from http://www.dsuk.biz/SmartType/SmartType/Examples.html. 

Import a metaphase image into SmartType by selecting Import… from the Case menu.

Import Dialogue

Use the Import dialog to locate the TIFF file containing the metaphase image. Make sure you select 
Bright Field if you are karyotyping a bright field image (dark chromosomes against a light background)
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Threshold the Metaphase Image
SmartType will import the selected file, and present the metaphase image and the Threshold dialog.

Loaded Metaphase and Threshold Dialog

On opening the image, SmartType separates the chromosomes from the background, and those that it 
recognises as chromosomes are outlined in blue. SmartType uses a threshold with which to separate the 
foreground (chromosomes) from the background. The threshold can be adjusted with the Threshold 
dialog.

SmartType initially assesses the image and sets an initial threshold level. The threshold level will 
determines the boundary between the foreground and background. Increasing the threshold level will 
enlarge the blue outlines, decreasing the threshold level will shrink the blue outlines. As the threshold is 
increased and the outlines enlarged, it becomes more likely that the boundaries to adjacent chromosomes 
will overlap and join and so prevent SmartType from identifying a chromosome. Reducing the threshold 
and shrinking the outlines may result in parts of the chromosome being considered as background. In the 
extreme, the chromosome may start to show holes or even get separated into multiple parts.

The aim is to find a threshold that results in the maximum number of chromosomes being identified with 
the minimum amount of erosion to the outline boundaries of the chromosomes. 
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Click on the Default button to have SmartType choose a suitable threshold level, select 3 from the 
Aggression  popup menu, then click OK

Threshold Dialogue

Enhance the Image Appearance
The Normalisation dialog will appear, this controls the appearance of the metaphase image, Adjust the 
settings to appear as below:

Normalisation Dialogue
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Editing the Metaphase
SmartType displays the metaphase and the karyotype within a document window that is partitioned into 4 
areas. 

· Tool bar (at the top of the window) containing buttons for the most commonly used 
tools.

· Working panel (the large panel on the left) where you perform most of the editing 
operations in this area. It can display either the metaphase or karyotype.

· Overview panel (the top right panel). This will display either the metaphase or 
karyotype; whichever is not being displayed in the working panel.

· Zoom panel (bottom right panel). This will display a zoomed in view of whatever 
objects are currently selected. This makes it easier to perform metaphase editing 
operations for small details.

Next you use the metaphase editing tools to separate touching and overlapping chromosomes. 

Metaphase View
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Use the Select tool to select objects in the metaphase. Selected objects are highlighted with a red outline 
in the metaphase view and with a red bar in the metaphase view. The selected objects are also displayed 
in the zoom panel. With the Select tool you can click on any objects to select them or click and drag to 
select multiple objects. Subsequent editing operations such as cutting, joining and resolving overlaps are 
restricted to the selected objects. Using the Select tool and clicking on the background has the effect of 
selecting nothing. With nothing selected it is the same as having everything selected and editing 
operations can be applied to any object.

Use the Free Cut tool to cut apart touching chromosomes. Select the Free Cut tool then click and drag 
to define a cut that separates the two touching chromosomes.

Free cut Tool for Cutting Apart Touching Chromsomes

You can perform the cutting operation in the main panel or if the details are small, select the item to be 
edited and then perform the operation in the zoom panel where the selected object will be magnified.

 

Editing in the Zoom Panel

Use the Overlap tool for resolving overlapping chromosomes. To use the overlap tool in automatic 
mode select the overlap tool and double click at the centre of the overlapping chromosomes:
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Overlap Tool in Automatic Mode Resolving Overlap

Use the Overlap tool to resolve the remaining overlap. This time use the overlap tool in manual mode. 
Select the Select tool and select the overlapping chromosomes, the outline should turn red. Select the 
Overlap tool and click and drag to paint over one of the chromosomes. Use the up arrow and down 
arrow on your keyboard to change the size of the Overlap Tool paint brush. Release the mouse at the end 
of painting the first chromosome and repeat the operation for the second chromosome.

Overlap Tool in Manual Mode resolving Overlap

Use the Free Cut and Overlap tools to separate all remaining chromosomes. You may find that you have 
objects that have been included as chromosomes that are not actually chromosomes, for instance spurious 
bits of dirt or fragments of  interpahse cells. To exclude these objects from the karyotype select them and 
then click on Exclude from the tool bar.

You should now have separated all 46 chromosomes, the number of chromomsomes is displayed at the 
top right of the tool bar

The thresholding has caused a couple of the chromosomes to be missing their telomeres. Use the Join tool 
to extend these chromosomes. Start by using the Select tool to select the chromosome to be extended, 
then use the Join tool to paint in the end of the chromosome. Again you can use the up arrow and down 
arrow on the keyboard to adjust the size of the join tool brush.
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Join Tool Used to Extend Chromosome

The metaphase editing is now complete.

Create the Karyotype
Swap the metaphase and the karyotype views by clicking on the Swap Views toolbar button. 

Karyotype in Main View

There will still be some errors that you will need to correct manually.
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Select Auto Classify from the Classify menu to let SmartType automatically classify the karyotype.

Auto Classification

Use the Select tool to click and drag chromosomes to their correct position in the karyotype.

Use the Rotate tool to rotate chromosomes into their correct orientation. Note: you can double click on 
a chromosome with the Rotate tool to rotate it by 180°.

From here you should go on to read the rest of this manual that give a detailed description of the 
SmartType tools.
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Choosing Commands Using Keyboard Shortcuts
Many of the commands is SmartType can be performed using a keyboard shortcut. All Keyboard short 
cuts are performed by holding down the  together with a letter or number key.

All the menu entries that can be activated by a keyboard shortcut will have a shortcut letter appearing at 
the right hand side of the menu item. All the Tool icons that can be activated by a shortcut will display 
some help text including the shortcut key to be used, if you leave the mouse of the tool icon for a few 
seconds.

Command Shortcut List
H Hide SmartType This will hide all the SmartType windows. Use this to view 

windows from other applications if the SmartType window is 
obscuring them. To show the SmartType windows click on the 
SmartType icon in the Mac Dock at the bottom of the screen.

Q Quit SmartType Surely you don’t want to do that!

S Save Save the current karyotype

W Close Close the current karyotype. You will be an option to save the 
document if the karyotype has been modified..

P Print… Print report

Z Undo This is your friend!

A Select All This command will cycle through, Selecting all Chromosomes, 
Selecting all objects (including non chromosome objects), 
deselecting everything.

X Select Tool Click objects to select them. Hold down shift key to add to selection. 
Click and drag box around multiple objects.

C Cut Tool Cut apart touching objects

V Overlap Tool Resolve Overlaps

B Join Tool Join separated objects, extend objects or fill in holes in objects.

I Include Tool Include selected object in karyotype (only available in the 
Metaphase window)

E Exclude Tool Exclude selected object from the karyotype (available in both 
Metaphase and Karyotype windows)

R Rotate Free hand rotate tool, double click to rotate by 180°

K Import Import one ore multiple metaphase images into the current case.

SmartType Cases
SmartType organises its documents into cases. For each new case SmartType creates a case folder. All 
karyotype documents belonging to a case are stored together in their case folder. Information associated 
with each case “case information”, such as patient name, age etc. can be associated with a case. New 
karyotypes are created by using Import… from the Case menu to import a metaphase image into a 
case. Any details define in the case information that are defined in the karyotype are copied into the 
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details associated with the karyotype “karyotype information”. This feature saves on having to re-enter 
details such as patient name every time you start a new karyotype.

Opening a Case
Select Open Case... from the Case menu. This will present the Open Case dialog in which all the 
available cases are listed. You can enter a partial case name in the Search field and all the list of cases is 
filtered to show only those cases that match. Click the OK button to open the selected case.

Open Case Dialog

Creating a New Case
Select New Case... from the Case menu. This will present the New Case dialog.

New Case Dialog

Enter the name for the case. Note that the case name will be used to identify the case and must be unique. 
SmartType will warn you if you attempt to use a case name that has already been used.
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This will be followed by the Case Info dialog.

Case Info Dialogue

Closing a Case
Select Close Case from the Case menu to close a case. Any karyotypes belonging to that case will be 
closed. For each open karyotype belonging to the case that has been modified but not saved, a dialogue 
will be presented offering you the option to save the karyotype.

Deleting a Case
Select Delete Case... from the Case menu to delete a case. You will be prompted with a question 
asking if you are sure if you want to delete the case. All karyotypes belonging to that case will be deleted 
along with the case folder.

Warning: This operation cannot be undone!
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Case Info
You can examine and change the case information by selecting Case Info... from the Case menu.

Case Info Dialogue

Case View
An open case will be displayed in a case view.

Case View
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You can select one or more karyotypes in the case view much the same way as you can select multiple 
cells in a spreadsheet. Use the shift key to extend your selection or use the command key to add 
additional karyotypes to your selection. The case view window can be resized and will automatically be 
laid out with as many columns as will fit into the window.

Opening Karyotypes from the Case View
Double clicking on an entry within the case view will open that karyotype document.

With one or more karyotypes selected in the gallery view, use Open Selected Karyotypes from the 
Cases menu to open all the selected karyotypes.

Deleting Karyotypes from the Case View
With one or more karyotypes selected in the gallery view, choose Delete Selected Karyotypes 
from the Cases menu to delete all the selected karyotypes. Note once a karyotype is deleted, there is no 
way to recover it.

Reassigning Karyotype Species from the Case View
The species for a given karyotype is usually assigned when you import the metaphase, however if a 
mistake has been made it is possible to reassign the species as follows:

· Make sure all karyotypes are closed.

· Select the karyotypes in the Case View for which you wish to change the species.

· Select Change Species… from the Case menu 

Species Change Dialogue

· Choose the target species and then press OK.

Each of the selected karyotypes will be updated. The Karyotypes will appear in the Case View with their 
karyotype thumbnail blank. Open each of the updated karyotypes and make a small change, such as 
selecting a chromosome and Save the karyotype to cause it’s karyotype thumbnail to be updated.

Note: When you reassign a species for a karyotype, chromosome classes are preserved where they exisit 
in both the source and target species e.g. a chromosome 12 will remain a chromosome 12 when changing 
from the human species to pig. Chromosome with a class does not exist in the target species (because the 
target species has fewer chromosome classes that the source species) 

Warning: Reassigning a karyotype species cannot be undone.
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Relocating the Case Root Folder
Cases are stored within folders on the file system. The parent folder containing the case folders is called 
the case root folder. When you start SmartCapture for the first time, the location of the case root folder is 
set to SmartType Cases and is located in the user’s home directory.  Use Choose CaseRoot… 
from the Cases menu to select a new location for the case root folder.

If you have multiple SmartType workstations, you can use a file server for the case root folder so that all 
workstations can share access to the cases.

You can also have multiple case root folders to help organise your work, for example, you may organise 
all the cases by date having a different case root folder for each year. In this way you can avoid the 
number of case per case root folder becoming too numerous.

Downloading Examples Cases
Select Download Example Cases… from the Case menu to download example cases from the 
Digital Scientific UK website. You will be presented with a dialogue from which you can choose from a 
list of example cases to be downloaded. Note you need to have internet access to the Digital Scientific 
UK web site for this to work.

Example Case Download Dialogue

Case Locking
SmartType can be configured so that a case can be shared (opened by more than one user) or exclusive 
(opened by at most one user). Set case_locking in the SmartType_Setup.properties file to true for 
exclusive case access.

Montage of Imported Images
In cases where a metaphase covers an area which is larger than will fit in a single field of view, it is 
necessary to collect multiple images cover the required field of view. Where multiple images have been 
imported these have to be stitched together to form a montage of the image to cover the whole area of 
interest.
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If multiple images are selected using the Import dialog, theses images will be displayed in the Frame 
Layout window.

Frame Layout Widow

At the top of the are the following buttons:-

Frame Layout Control Buttons
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Use he Select Image tool to click on each of the images and drag them into the correct positions relative 
to one another. Don’t worry about getting the positions perfect. The Snap Images tool can be later used to 
provide position the images precisely.

Use the Stack Images tool to rearrange the stacking order of the images.

You can exclude an image from the montage, by selecting it and the clicking on the Delete Image tool

You can lay all the images out so using the Tessellate Image tool.

Once the images have been positioned correctly you can get SmartType to snap the images 

Use the Snap Images tool to automatically snap the images together. 

Frame Layout Window with Images Aligned

Click on the OK Button to complete the montage operation.

Thresholding
The metaphase image is now presented for thresholding. Thresholding is the operation that separates the 
background from the foreground. SmartType will identify the objects and draw a blue outline around 
objects that it identifies as chromosomes and a grey outline around other objects.
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The Threshold dialog is presented. Use the slider to adjust the threshold level. When you release the 
threshold slider, the image will be re-thresholded to the new level. You will see outlines of the identified 
objects either contract or expand as the slider is moved to different positions.

Threshold Dialog

Thresholded Objects

The aim is to find a threshold value that separates the chromosomes from the background without eroding 
any of the chromosome edges.

Use the Default button to let SmartType choose an appropriate threshold value.

Once you have selected an appropriate threshold level dismiss the threshold dialog by clicking on OK.

The image can be subsequently re-thresholded by selecting Threshold Metaphase… from the 
Karyotype menu.
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Initial Normalisation
The brightness and contrast can now be set for the image.

Adjust Normalisation Dialog

There are two sliders that control the black level and the white level in the image. Try adjusting these to 
get a feel for how you can change the image brightness and contrast.

Dismiss this dialog by clicking on OK.

Image normalisation can be subsequently adjusted through the image palette which is accessed by 
selecting Image Palette from the View menu.

Karyotype Information
Select Show Information… from the Karyotype menu to show the Karyotype information dialogue. 
You can add information that will be stored into the karyotype document. When creating a new 
karyotype, any fields with the same name in the Karyotype Information that are present in the Case 
Information will be copied from the Case Information. This can be used to avoid re-entering key 
information such as Name and Dat of Birth for every new karyotype for a given case.

Image Info Dialog
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SmartType Document Window

SmartType Document Window

SmartType displays the metaphase and the karyotype within a document window that is partitioned into 4 
areas. 

· Tool bar (at the top of the window) containing buttons for the most commonly used 
tools.

· Working panel (the large panel on the left). You perform most of the editing operations 
in this area. It can display either the metaphase or karyotype.

· Overview panel (the top right panel). This will display either the metaphase or 
karyotype; whichever is not being displayed in the working panel.

· Zoom panel (bottom right panel). This will display a zoomed in view of the currently 
selected objects. This makes it easier to perform metaphase editing operations for small 
details.

The Swap Views button swaps the metaphase and karyotype in the working panel and overview panel.
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Editing a Metaphase
Before you can start editing a metaphase, you must have imported a metaphase or opened an existing 
SmartType document and have the metaphase displayed in the main panel.

Editing a metaphase is accomplished with the editing tools. Initially when the images has just been 
imported some of the chromosomes may have been correctly identified, but others will have their 
boundaries touching each other and so appear not as individual chromosomes but grouped together as a 
cluster. Other chromosomes will be overlapping each other and some non-chromosome objects e.g. dirt, 
may be present in the images too. The aim is to separate each of the chromosomes, resolve any overlaps 
and remove from consideration any non-chromosome objects.

Selection of a Metaphase

Objects in the Metaphase that SmartType considers as chromosomes are outlined in blue (providing 
Outlines is checked in the View menu). Any groups of chromosomes that are touching or overlapping 
are outlines in grey and referred to as clusters.

Clusters with overlaps and touching chromosomes are edited using the tools in the Metaphase Window
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Undo Editing a Metaphase
It can be easy, particularly when learning how to use SmartType, to make mistakes whilst editing. All of 
the editing operations can be undone by clicking on Undo from the Edit menu.

Editing Tools for Metaphase

Selection
The Selection tool is used to select an object. Objects have to be selected in order for them to become the 
target of some of the other editing operations.  

Selected objects are outlined in red in the metaphase and highlighted with a red under line in the 
karyotype view. The karyotype view and metaphase view are synchronised so an object selected in one 
view is always selected in the other.

Selection of a Single Object
To select a single object, click on the Selection tool then click on the object to be selected. You can select 
a different object simple by clicking on another object.

Selecting Multiple Objects
Multiple objects can be selected by selecting a single object as above and the holding the Shift key down 
and click on other objects. Each new object clicked on gets added to the selection. If you click on an 
object that is already selected, it becomes deselected.

Select All Objects / Select All Chromosomes
You can select all the chromosome by clicking on Select All from the Edit menu. This will select all 
objects that are chromosomes but exclude objects that are not considered chromosomes. Selecting Select 
All from the Edit a second time will select all objects (chromosomes and non chromosomes). Selecting 
Select All from the Edit a third time will deselect everything.

Selecting No Objects
You can clear the current selection by clicking on the selection tool and then clicking on the background 
in the Metaphase Window

Page 34 of 66



Cutting
Use the Cut tool to separate touching chromosomes. There are two cutting tools, Free Cut and Poly 
Cut. The two tools can be accessed by clicking on the small black disclosure triangle on the Cut tool 
button.

The Free Cut performs a cut by clicking and dragging the mouse in a freehand operation, the Poly Cut 
performs a cut by making several discrete clicks at different locations and a cut is performed in straight 
line segments between the location of the clicks. The Poly Cut is terminated with a double click.

Any Cut operation can be aborted by pressing the ESCAPE key during the cutting operation.

Cut Tools

There are three modes for both of the cutting tools. These modes are automatic, manual and restricted 
manual.

Automatic Cutting
Automatic cutting makes separating touching chromosomes very easy. It automatically cuts the objects 
apart by identifying a valley of background intensity that runs between the objects. Automatic cutting 
operates identically whether using the  Free Cut tool or the Poly Cut tool.

With no chromosomes selected, click on the Cut tool. The cursor will change to an icon of a pair of 
scissors. Double click with the points of the scissors where the chromosomes are touching. 

Before Cutting Touching Chromosomes

After Cutting Touching Chromosomes
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Manual Cutting
Sometimes automatic cutting is not possible because there is no clear valley of background intensity 
between the touching objects in this case you can manual cut the objects apart. 

Manual Cutting (Free Cut)
With no chromosomes selected, click on the Cut tool. The cursor will change to an icon of a pair of 
scissors. Using the points of the scissors click where you want to start the cut. Hold down the mouse 
button and move the scissors cursor along the path you want the cut.  As the scissors move, a yellow line 
is drawn indicating the path of the cut. Finish the cut operation by releasing the mouse button.

At Start of Cut

During Cut

After Cut Complete

Manual Cutting (Poly Cut)
Manual cutting with the Poly Cut tool behaves in a similar way to manual cutting with the Free Cut 
tool except that the cut is defined by a series of clicks and terminated with a double click.

Cutting with Poly Cut
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Restricted Manual Cutting
In areas of the metaphase that are crowded by lots of objects it can be difficult to ensure that a manual cut 
doesn’t inadvertently cut into a nearby object that you are not intending to be cut. In this situation you can 
restrict the target of a manual cut operation by selecting the cluster to be cut (it’s boundary will be drawn 
in red) and then proceeding as with the manual cut. If the cut line goes through any unselected objects 
those objects will remain uncut.

Resolving Overlaps
Often two or more chromosomes will overlap one another. The Cut tool cannot be used for overlaps since 
it can only partition an object and the area in common to the two or more overlapping parts will be 
excluded from all but one of the partitions.

Overlapping Chromosomes

Use the Overlap tool for resolving overlaps. The Overlap tool has two modes of operation. These modes 
are automatic and manual.

Automatic Resolve Overlap
Automatic Resolve Overlap makes resolving overlapping chromosomes very easy. It automatically 
separates the overlapping parts by identifying where two objects form a clear cross.

With no chromosomes selected, click on the Overlap tool. The cursor will change to an icon of a knife 
with a little Q Double click with the point of the knife at the centre of the intersection of the overlapping 
area. 

If SmartType car resolve the overlap, the two overlapping parts will be highlighted in different colours. If 
the overlap cannot be resolved there is no object highlighting.

    

Before and After resolving overlap

Note that unlike the Cut tool the overlapping portions are retained in all of the resolved objects.
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Manual Resolve Overlap
Sometimes automatic resolve is not possible because there is no clear cross at the intersection of the 
objects. In this case you can manually resolve the overlapping objects. 

Start by selecting the overlapping chromosomes to be resolved. 

Overlapping Objects Selected

With the overlapping objects selected, click on the Overlap tool. The cursor will change to a circular 
paint tool. Use the keyboard up arrow and down arrow keys to increase and  decrease the size of the paint 
tool. Adjust the pain tool size to being slightly larger than the chromosome width.

Painting 1st Overlapping Chromosome

Paint along each of the chromosomes to be resolved. Each chromosome is over-painted with a translucent 
colour. Initiate the paint operation by clicking the with the circle paint tool at the start of the first 
chromosome to be resolved. Paint along the length of the chromosome. Release the mouse when have 
reached the end of the chromosome. The area painted will be restricted to within the boundary of the 
selected cluster. Terminate the operation by selecting the Select tool. Repeat the operation for the other 
chromosomes in the cluster. Note that each time you use the overlap painting tool to define a new 
chromosome, the colour of the translucent paint will change.
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Painting 1st Chromsome, Painting 2nd Chromosome, Chromosomes Resolved

Tip:  Continue  painting  slightly  beyond  the  end  of  the  chromosome  to  ensure  that  the  whole 
chromosome is painted.

Tip: Setting a brush width slightly larger that the width of the chromosomes makes the job a lot  
easier!

Tip:  If  the  paint  tool  brush  width  is  not  quite  wide  enough,  you may find  some parts  of  the 
chromosome are not completely painted. Without releasing the mouse button, go back over any 
unpainted areas.

Tip:  Once  you  have  started  painting  over  a  chromosome  do  not  release  the  mouse  until  that 
chromosome is completely painted. If however you do release the mouse too early or if you have 
painted the chromosome incorrectly, use Undo and start the painting of that chromosome again.

Note it is important that you isolate ALL of the portions to be retained in the karyotype before going on to 
other operations. When you have isolated all the chromosomes, you can go on to any other editing 
operation.

Tip: Perform the operation  in the Zoom panel to make the process easier.

Join
Sometimes due to thresholding or accidental cutting, portions of a chromosome get separated or have 
holes on them. Use the Join tool to join together separated parts of an object a fill in holes.

Joining Separated Objects
Select the objects to be joined

Click on the Join tool use the paint tool to paint over the selected objects and the area that you wish to 
add to the selection.

Chromosomes selected, Joining two parts of a chromosome, extending one end of a chromosome, 
extending two ends of a chromosome.
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Tip: Use a brush width slightly less than the width of a chromosome can make the job easier. Adjust 
the witdh of the join tool brush by using the up arrow and down arrow keyboard keys.

Filling in Holes Using the Join Tool
Select the object with the hole or holes.

Click on the Join tool and paint over the selected object ensuring that you paint over any enclosed holes.

Tip: Use the Fill Holes command to automatically fill in holes

Erode
The boundary defining an object can be eroded or shrunk by using the Erode command. Start by selecting 
the object or objects to be eroded. Then select Erode from the Edit menu.

Chromosome Before Erode
 

Chromosome After Erode

Dilate
The boundary defining an object can dilated or enlarged by using the Dilate command. Start by selecting 
the object or objects to be dilated. Then select Dilate from the Edit menu.

Chromosome Before Dilate
 

Chromosome After Dilate
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Fill Holes
Objects that have holes within them can have the holes filled in by using the Fill Holes command. Start 
by selecting the object or objects to have the holes filled. Then select Fill Holes from the Edit menu.

Chromosome Before Fill Holes

Chromosome After Fill Holes

Tip: With certain preparations you may find that after thresholding, there are a great many holes in  
chromosomes and cluster. Select all the objects with holes by dragging the selection tool around all 
the objects or use Select All from the Edit menu, and then use Fill Holes to fill in all the holes in 
one go.

Split Clusters
Use Split clusters to automatically break apart clusters of chromosomes. You can select one or multiple 
clusters and then select Split Clusters from the Edit menu.
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Editing a Karyotype
Before you can start editing a karyotype, you must import a metaphase or opened an existing SmartType.

Editing a karyotype is accomplished with the editing tools in the Karyotype window. Use Swap Views 
so you have the karyotype displayed in the main panel.

It is likely that some of the chromosomes will have been incorrectly classified. Essentially the aim is to 
correctly classify all of the chromosomes, and make sure that all the chromosomes are the right way up 
and positioned correctly relative to their centromeres.

Undo Editing a Karyotype
It can be easy, particularly when learning how to use SmartType, to make mistakes whilst editing. All of 
the editing operations can be undone by clicking on Undo from the Edit menu.

Editing Tools for Karyotype

Karyotype Editing Tools

Selection
The Selection tool is used to select an object. Objects have to be selected in order for them to become the 
target of some of the other editing operations.  Selected objects are underlined in red in the karyotype 
view.

Selection of a Single Object
To select a single object, click on the Selection tool then click on the object to be selected. You can select 
a different object simple by clicking on another object. If you click on an object that is already selected, it 
becomes deselected.

Selecting Multiple Objects
Multiple objects can be selected by selecting a single object as above and the holding the Shift key down 
and click on other objects. Each new object clicked on gets added to the selection. If you click on an 
object that is already selected, it becomes deselected. You can also click and drag a marque 

Select All Objects / Select All Chromosomes
You can select all the chromosome by clicking on Select All from the Edit menu. This will select all 
objects that are chromosomes but exclude objects that are not considered chromosomes. Selecting Select 
All from the Edit a second time will select all objects (chromosomes and non chromosomes). Selecting 
Select All from the Edit a third time will deselect everything.

Selecting No Objects
You can clear the current selection by clicking on the selection tool and then clicking on the background 
in the Metaphase Window
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Cutting
If any the clusters of chromosomes were not cut apart in the Metaphase window, it is possible that they 
will be included in the Karyotype window. Use the Cut tool as described in Metaphase Cutting section

Classification
Warning

SmartType provides automatic chromosome 
classification for assistance, but final 
classification and interpretation in relation to 
medical use is the responsibility of the qualified 
operator.

Classification is the process of assigning each chromosome to its correct karyotype class. There are two 
methods of classification, manual and automatic. Automatic classification requires a classifier that has 
been built specifically for the metaphase material and being analysed and the specific banding protocol 
being used. E.g. Human chromosomes prepared for G-banding. The SmartType automatic classifier 
software is trainable, i.e. a new automatic classifier can be built by presenting the classifier with a set of 
correctly karyotyped metaphases. 

Classification Options
Since different samples and preparations require different classifiers, it is important to ensure that the 
correct classifier will be used. There are a number of other operations that you will want to set before 
starting karyotyping.

Click on Show Options… from the Karyotype menu to get the Default Options dialog. Chose the 
appropriate setting for your preparation and then dismiss the dialog by clicking on OK.

 

Karyotype Options Dialog

Note: If you open the Karyotype Options dialog when a metaphase is already open, the options dialog is 
titled “Options” and the chosen options are associated with the open document. If you open the Options 
dialog with no metaphase open, then the dialog is called “Default Options” and the options are used as a 
default for newly imported metaphases.

Automatic Classification
Select Auto Classify from the Classify menu to let SmartType classify all the chromosome.
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Manual Classification
Chromosomes are manually classified in the Karyotype window simply by dragging chromosomes to the 
desired class position in the karyotype.

When you drag a chromosome to a location where it can be dropped you will be shown a rectangular drop 
zone when it can be inserted into the karyotype. If you drag to a position over an existing chromosome 
the chromosome being dragged will be swapped with the one it is dropped on to.
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Enhancing the Image
The metaphase and karyotype image can be enhanced. The image enhancements are divided into two 
types

· Brightness, contrast, gamma and colour

· Banding enhancement

All the images enhancement functions are available on the histograms tab of the Image Palette. The 
Image palette is display by clicking on Image Palette in the View menu. In the example below there 
is a single image plane.

Image Palette for Monochrome Image

Brightness, Contrast, Gamma and Colour
For each image plane there are the following controls

Enable – This determines whether the plane is displayed in the image. This is only of use in multi-plane 
images where you may want to look at a specific group of planes.

The Plane Colour Swatch is used to set the colour for the plane. This is mainly used for multi plane FISH 
images.

The Histograms displays a bar chart representing the frequency of pixels of a given brightness. The left 
hand side of the histograms shows pixels with low intensity and towards the right hand side the pixels are 
of a higher intensity. The Dark Level and Bright Level can be adjusted to change the brightness and 
contrast of the image. In this example there is only a single histogram because there is only a single 
colour plane. 

Moving the Dark Level to the right will make more of the background appear black. Moving the Bright 
Level towards the left will make more of the bright parts of the images appear saturated. In this way you 
can change the brightness and contrast of each plane independently.
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Tip: You can invert the image by dragging and swapping the positions of the  Dark and  Bright 
Levels. Inverting the image is particularly useful for enhancing the image when Q-banding or Dapi-
banding.

Clicking on the Colour Swatch will display a colour picker dialog. This is used to set the colour of the 
plane. This is mainly used for multiplane FISH images.

The Brightness/Darkness Slider at the top of the palette gives an overall control of the image brightness 
and applies equally to all planes.

Brightness, contrast and colour settings can be applied globally to the metaphase window and/or locally 
to selected chromosomes in the karyotype window.

The Gamma control can be used to adjust the gamma correction. Increasing the gamma to 1.8 or 2.0 and 
the adjusting the dark level can greatly improve the appearance of G-band and R-band chromosome 
banding patterns.

If the Metaphase window is selected, settings for the image brightness, contrast and colour will apply 
globally to the whole metaphase. Any settings will also be applied to any chromosomes in the karyotype 
window that have not had local settings applied.

Local settings to brightness, contrast and colour can be applied to selected chromosomes in the karyotype 
window. Note the controls on the image palette to set the Brightness, contrast and colour settings become 
disabled if you select multiple chromosomes in the karyotype window that have different brightness, 
contrast or colour settings. In this situation an additional revert selected button will be visible on the 
palette and the will restore the brightness, contrast and colour settings of the selected chromosomes to the 
global settings used for the metaphase.

Tip: If you want to revert all of the karyotyped chromosome’s brightness and contrast settings back 
to the settings used in the metaphase window, select all the chromosomes (click on Select All in the 
Edit menu) and then click on revert selected in the image palette.

Banding Enhancement
The Banding Enhance Filter is used to sharpen the banding on chromosomes. The settings apply globally 
both to the whole metaphase and to the karyotype.
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Composite Karyotype
SmartType can produce a composite karyotype from multiple karyotypes. The composite karyotype will 
displays multiple karyotypes arranged in a table with the chromosomes arranged by class.

Composite Karyotype

A composite karyotype can be generated for all of the open karyotypes by selecting Composite View 
from the Windows menu.

Tip: See the section  Opening Karyotypes from the Gallery View to conveniently open multiple 
karyotypes on one go.

In the composite karyotype each open karyotype is displayed in a column. Each row in the composite 
view corresponds to all the chromosome of a given class for all of the karyotypes.

Chromosomes can be reclassified by drag and drop within a given column, i.e. belonging to the same 
karyotype.
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When ever a chromosome is selected in the composite karyotype, the karyotype document belonging to 
the selected chromosome is brought to the front.

Composite View with Selected Karyotype

To undo a classification made in the composite karyotype, click on the karyotype document window, and 
select Undo from the Edit menu

The composite karyotype can be zoomed in/out and exported as a PNG image.
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Printing Reports
Printing a report of a karyotype is requires the following steps

· Selecting a print template

· Requesting the print

Selecting Print Template
Select Choose Print Template… form the Karyotype menu. You will be presented with a dialog 
that allows you to choose the print template. This selection is remembered for all subsequent prints.

Requesting The Print
Click on Print… from the Karyotype menu. This will display the standard print dialog where you will 
be able to select the destination printer and make any necessary changes to the printer options. If your 
computer supports it, you can print to a PDF file or preview the print before making a hard copy.

Installing New Print Templates
<To be added>
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Example Print Report
This is an example of a printed report.

Example Print Report
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MFISH
MFISH is a technique for identifying multiple targets by painting the targets with unique combinations of 
fluorochromes. In its most commonly used mode each pair of homologous chromosomes are painted with 
a different combination of fluorochromes. Because combinations of fluorochromes can be used, the total 
number of targets that can be uniquely identified is given by the formula 2n – 1 where n is the number of 
fluoorochromes used. For example if 2 fluorochromes, TexasRed and FITC are used then 22 – 1, three 
targets can be labelled. One labelled with TexasRed, one labelled with FITC and one labelled with a 
combination of both fluors. The full complement of human chromosomes, 23, can be uniquely identified 
by using 5 fluorochromes 25 – 1 = 31. Commercial available MFISH kits are available. The MFISH kits 
will use a particular set of fluorochromes. An assignment table detailing which chromosome targets are 
painted with which combination of fluorochromes will accompany the MFISH kit.

Fluorochrome Configurations
Whenever you are required to specify a fluorochrome you can enter a name any colour however 
SmartType allows you to select from a standard set of flourochromes. This standard set is detailed in a 
file called Fluors.xml which is located in the SmartType application directory.

MFISH Configurations
Each MFISH kit will use a particular set of fluorochromes in a particular combination for identifying each 
target chromosome. These MFISH configurations are chosen from the Options dialog.

New MFISH configurations can be added to SmartType by the addition of extra MFISH Configuration 
files. These files are located within the MFISHConfig directory within the current SmartType case root 
folder.

Standard MFISH Configuration files are supplied for some of the popular MFISH kits that are available. 
Contact Digital Scientific UK Ltd. if you require a configuration that is not supplied.

Procedure for Using MFISH
MFISH requires as input multi page TIFF images. See Using ImageJ to Make Multi Page TIFF 
Image.
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Analysing an MFISH image is a straightforward procedure.

1. Click on Options… from the File menu to display the Default Options Palette. Select the species 
to choose the required karyotype layout (Note selecting the species must be done before an image 
is opened). Select the MFISH Configuration according to the MFISH kit you are working with. 
There are three methods for performing the MFISH analysis. We recommend using the “Em with 
fixed seed” method. This method takes the longest time to complete but the results are the best.

Selecting The MFISH Configuration & Method

2. Select Import…  from the File menu to select a multi page TIFF file containing the multi 
channel metaphase image.

3. Using the Threshold dialog select the counterstain plane and threshold the image. You will see the 
threshold outlines change as you select different threshold plane. Adjust the other threshold 
settings as described in the Thresholding section.

After selecting the threshold plane click on the Default button to have SmartType select a suitable  
default value for the selected counterstain plane.

Page 52 of 66



Selecting Counterstain Plane for Thresholding

4. Using the Adjust Normalisation dialog adjust the image levels and band enhancement. 

Adjusting Normalisation and Band Enhancement

5. Open the Image Palette by selecting Image Palette from the Windows menu. Click on the 
fluors tab. Here you can assign or reasign a name and colour to be used for each plane. The fluor 
popups allow you to select from a predefined list of known fluorochromes. Selecting a fluor from 
the list will set that plane’s flour name and colour. You must select fluor names that exactly match 
the fluor names as described in the MFISH Configuration that you are using. 

Assigning Fluors in the Image Palette

6. Use the metaphase editing tools to separate the chromosomes. This is covered in the section 
Editing a Metaphase. The techniques for editing a multiplane mataphase are the same for editing a 
single plane metaphase.
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You may find it easier to edit the metaphase if you hide all but the counterstain plane. You do this 
by selecting the  histograms tab of the  Image Palette and then deselecting any planes you wish to 
hide. Remember to re-enable the planes once you have finished editing the metaphase.

7. Select Compute MFISH from the Operations menu. This will replace the blended image with 
the MFISH painted image.

 

Section of Metaphase before and after Computing MFISH

8. Select Karyotype from the Windows menu to open the karyotype window.

9. Select Classify by MFISH from the Operations menu to classify the metaphase.

10. Make any corrections to the classification by using the techniques described in the Editing a 
Karyotype section.

Using ImageJ to Make Multi Page TIFF

SmartType MFISH requires the metaphase images for the multiple flourochromes to be combined into a 
single multi-channel TIFF image with each channel image given a channel name that will be used to 
match the fluorochrome used in the MFISH protocol mapping.

Use ImageJ to combine a set of metaphase channel images into a single multi-channel TIFF image.

Image J is a free to use general purpose Image manipulation program.

You can down load it for free from https://imagej.net/ij/

Start by naming each of the channel images with the name of the fluorchrome used for the image. 
Typically for an MFISH human assay you will have six TIFF image files. Depending on the MFISH 
protocol that you are using, the fluorochromes used might be Dapi, Fitc, Cy3, Cy3.5, Cy5, Cy5.5. 
Assuming the images are captured and saved in TIFF format the channel image files should be named: 
Dapi.tif, Fitc.tif, Cy3.tif, Cy3.5.tif, Cy5.tif, Cy5.5.tif.

Open all the channel image files in ImageJ

You can drag and drop multiple image files from the file system onto the ImageJ toolbar to open 
multiple images all at once.
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Multiple image channel images open in ImageJ

In ImageJ select Merge Channels... from the Color sub menu of the Image menu and asign each of 
the images to a channel. The order of the assignment is unimportant so lomg as the images are named 
correctly. Make sure Create Composite is selected then click OK.
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Merge Channels Palette

This will combine the mutiple images into a single multi channel composite image.

Composite Multi channel Image

Select Save or Save As… to save the composite image to disk.
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Exporting Images

Exporting Metaphase as an Image
Select Export Karyotype… from the Karyotype menu to export the karyotype as a PNG image.

Select Export Metaphase… from the Karyotype menu to export the metaphase as a PNG image.
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Configuration Files

Location of Configuration Files
SmartType uses several configuration files. Configuration files are search for in the following locations 
and in the following order:

Type Comment Location

User 
Specific

Specific to the user. Apple OS-X

<user home>/Library/
Application 
Support/SmartType/

Windows

<user home>\Preferences\
SmartType\

Linux

<user home>/.loc
al/SmartType/

Case Root 
Specific

Applies to all users using 
this case root folder.

<case_root>/_Support

System 
Supplied

Applies to all SmartType 
users

Packaged within the application.

The configurations folder can contain the following:

File/Folder Name Description

defaultKaryProperties.xml XML file describing the fields to be associated with a newly created SmartType case  
and karyotype. Field names can include spaces.

When creating a new case, the user can supply information that will be common to 
all the karyotypes for this case. This is called the “case information”

When creating a new karyotype, the case information is copied into this karyotype 
thus saving the user to have to re-enter information . The user can also supply 
additional karyotype specific information and or edit the copied case information. 
This is called the “karyotype information”

metaKaryProperties.xml XML file describing the additional information to specify the format of fields to be 
associated with a newly created SmartType case and or karyotype.

This includes a list specifying the order in which the case properties should appear 
when displayed in a dialog, the type of a field e.g. text, date, integer, tags (a 
predefined list of values), and whether the value should be read-only

MFISHConfig Folder containing MFISH protocols

printTemplates Folder containing print templates and any associated image files.

Print templates are XML documents containing page layout information.

Fields defined in the defaultKaryProperties.xml file can be displayed in a print report 
by referring to the property in a print template file as ${Field Name}

species Folder containing support for additional species layouts and  ideograms

The SmartType_Setup.properties File
SmartType uses a setup configuration file and a preference file. The setup configuration file is called 
“SmartType_Setup.properties”. This file is a plain text file that contains a list of settings that modify the 
behaviour of SmartType. SmartType reads this file when it starts up. SmartType never modifies this file.
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The SmartType application contains its own “SmartType_Setup.properties” file, however, additional 
copies may be located in the SmartType case root directory and/or a user specific copy located in:

· For Apple Mac users:<user home>/Library/Application Support/SmartType/

· For Windows users:<user home>\Preferences\SmartType\

Properties read from the user specific copy override those read from the SmartType case root folder and 
those in turn override those read from the SmartType’s internal copy.

Below is an example SmartType_Setup.properties file. The file is a listing of names and values. Each line 
starts with the name, followed by an equals sign “=” followed by the value to be associated with that 
name e.g. “print.banner_fontsize = 16”. In this case the name “print.banner_fontsize” is set to the value 
16. The “print.banner_fontsize” defines the font size to be used for the banner printed at the top of the 
page when a report is printed. Comments, that server only to annotate the file and have no effect on the 
running of SmartType are introduced into the file by a hash sign “#”. Everything from the hash sign until 
the end of the line is ignored by SmartType.

#-------------------------------------------------------------------------------
# SmartType_Setup.propeties contains configuration SmartType settings. Settings
# are read by SmartType from copes of this file stored in the application
# bundle, a file  of this name in the case root directory and finally a copy
# user specific copy stored in (On MacOS X ) in: 
# <user home>/Library/Application Support/SmartType/ 
#
# properties are take in preference in thereverse order listed above. That is
# a user can override a property by creating a personal copy of
# SmartType_Setup.propeties containing only those properties that need to be o
# overridden.
#
#--- History -------------------------------------------------------------------
# Michael Ellis 19-MAY-2004 Tidied up & added history Concerns that 
comments at
# end of line cause parsing error
# Michael Ellis 15-OCT-2004 Suggested default file for shipping 
# Michael Ellis 23-MAY-2006 Updated for casemanagement options
# Michael Ellis 20-JUN-2008 Changed default location for case_path to 
"~/SmartType Cases"
# Michael Ellis 18-SEP-2008 Replaced case_path with case_path_mac & 
case_path_win variants
# Michael Ellis 06-MAY-2011 Removed database info
# Michael Ellis 11-AUG-2011 Added slideCoordinates to dem.fields
# Michael Ellis 14-AUG-2011 Added debug.level to control logging level

#--- Karyotype Specific Fields -------------------------------------------------
# Define fields associated with the karyotype.
# 1st a language-invariant string, then the translation
# NB Comments field is always present - it is not needed here
dem.fields = 
lastName,firstName,analysisNum,experimentTitle,slideNum,karyotype_status,slideCoord
inates

# Translations for each of these into the current language
lastName = Surname
firstName = First name
analysisNum = Analysis number
experimentTitle = Experiment
slideNum =  Slide number
karyotype_status = Karyotype Status
slideCoordinates = Slide Coordinates

# map special text info tags found in the tiff file from SmartCapture
# to tags used here and in PrintLayout
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# lhs is tag used in tiff file
# rhs is tag used in Demographics/PrintLayout
tifftag.slide_name = slideNum
tifftag.operator_name = operator_name
tifftag.patient_name = lastName
tifftag.experiment_comment = analysisNum
tifftag.comment = comment

#--- Settings for Print Reports ------------------------------------------------
# print.fields is a special tag defining the order in which the fields are to be 
presented in the UI
# Note that these must be recognised tags (same defined in dem.fields) prefixed 
with "print."
print.fields = 
print.karyotype_status,print.metaphase,print.karyotype,print.annotation,print.cross
es,print.numCrosses,print.numChromosomes,print.slideCoordinates,print.lastName,prin
t.firstName,print.analysisNum,print.slideNum,print.comment

# The translations of these tags into the required language
# Note that this does not fit the ResourceBundle pattern. We can only support one
# language with this file, so we have to supply the correct version of this for the 
target language

print.karyotype_status = Print Karyotype Status
print.metaphase = Print metaphase
print.karyotype = Print karyotype
print.annotation = Print annotation
print.crosses = Print crosses in metaphase
print.numCrosses = Print number of crosses
print.numChromosomes = Print number of chromosomes
print.slideCoordinates = Print Slide coordinates
print.lastName = Print Last name
print.firstName = Print First name
print.analysisNum = Print Analysis number
print.slideNum = Print Slide number
print.comment = Print Comment
print.banner = Digital Scientific UK Ltd

# Default settings for what gets printed on a report (overridden by the Print 
Options dialog)
print.metaphase.default = true
print.karyotype.default = true
print.annotation.default = true
print.crosses.default = false
print.numCrosses.default = false
print.numChromosomes.default = true
print.slideCoordinates.default = false
print.lastName.default = false
print.firstName.default = false
print.analysisNum.default = false
print.slideNum.default = false
print.karyotype_status.default = true
print.comment.default = true

# Font and layout parameters for the print report
print.banner_fontsize = 16
print.title_fontsize = 14
print.fontsize = 8
# the default layout (portrait or landscape)
print.default.layout = portrait
# print.offset specifies the mm offset from the top left of the page of (0,0) in 
page coords
# defined by the printer driver
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# This is subtracted from the .box coords when printing
print.offset = (0,0)
# print layout box specifications are in mm (left,top,width,height)
# NB all coords must be greater than print.offset
print.portrait.karyotype.box = (11,25,187,115)
print.portrait.metaphase.box = (11,145,187,90)
print.portrait.text.box = (11,240,187,45)
print.landscape.karyotype.box = (11,25,160,125)
print.landscape.metaphase.box = (176,25,110,125)
print.landscape.text.box = (50,155,200,37)
# print...only.karyotype.box is used when printing only the karyotype
print.portrait.only.karyotype.box = (11,25,187,200)
print.landscape.only.karyotype.box = (11,25,270,135)
# print...only.metaphase.box is used when printing only the metaphase
print.portrait.only.metaphase.box = (11,25,187,200)
print.landscape.only.metaphase.box = (11,25,270,135)
print.cross.size = 3
# set print.debug to outline defined boxes
#print.debug = true
#show the date/time at the bottom right of the printout
#print.showdatetime=true
# expand the exported jpeg to improve the resolution
print.expandforexport=1.5

#--- Annotation Settings -------------------------------------------------------
annotation.line.width = 2.2
annotation.line.end.type = arrow
annotation.line.end.arrow.size = 5
annotation.line.end.circle.radius = 2
annotation.line.colour = 0x1010FF
annotation.box.colour = 0x1010FF
annotation.box.linewidth = 2.2
annotation.text.colour = 0x1010FF
annotation.text.font = SansSerif
annotation.text.font.style = italic
annotation.text.font.size = 12

#--- Menu Key Shortcuts --------------------------------------------------------
# Use the meta key with the letter (ie Cmd or alt)
shortcut.menu.fileOpen = meta O
shortcut.menu.fileSave = meta S
shortcut.menu.capture = meta K
shortcut.menu.editSelectAll = meta A
shortcut.menu.PrintMetaphase = meta 1
shortcut.menu.PrintKaryotype = meta 2
shortcut.menu.Print = meta 3
shortcut.menu.imageInfo = meta F

# metaphase view toolbar key shortcuts
shortcut.toolbar.mselect = meta X
shortcut.toolbar.mcut = meta C
shortcut.toolbar.moverlap = meta V
shortcut.toolbar.mjoin = meta B
shortcut.toolbar.minclude = meta D
shortcut.toolbar.mexclude = meta E

# karyotype view toolbar key shortcuts
shortcut.toolbar.kselect = meta X
shortcut.toolbar.ktrim = meta C
shortcut.toolbar.krotate = meta R
shortcut.toolbar.kexclude = meta E

#--- General Settings ----------------------------------------------------------
# default image sense if tiff file doesnt specify (BrightField/Fluorescence)
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defaultImageSense = BrightField
# default classifier file
defaultClassifier = G_Band_28_06_02

# display the threshold dialog when opening a TIFF file
forceManualThresholdOnOpenTIFF = true

# display the image info dialog when capturing an image
openImageInfoOnCapture = true
openImageInfoOnOpenRawImage = true

# open the histogram dialog after capture
adjustNormaliseOnCapture = true

# open the karyotype view immediately after capture
autoOpenKaryotype = false

#this must be set true
histogramview.usebackbuffer = true

# set the margins around the application window
screenmargins = 0,0,0,80

#--- Case Management -----------------------------------------------------------
# These settings are for the case management.
case_management_enabled=true
# case_path is comma separated list of path names that specify where the SmartType 
cases folders
# should be located. The first path in the list will specify where new cases are 
created. Subsequent
# paths in the list are searched when opening exitiing cases.
# A "~" sympbol at the start of the path is used to designate the users home 
directory.
#
case_path_mac=~/SmartType 
Cases,/Users/Shared/Cases,/Applications/SmartType/SmartType Cases
case_path_win=~\\SmartType Cases
#
# Note: case_path was changed from "/Users/Shared/Cases" on 20-JUN-2008. Modify 
this variable
case_info.fields = lastName,firstName,analysisNum,case_status
# Natural language translation for the case fields
case_status = Case Status

# Case Management Gallery View Settings
# the size of the square to contain each thumbnail in the gallery
case.gallery.thumbnail_size = 160
# empty margin with outline around each thumbnail
case.gallery.thumbnail_margin = 2
# gap between rows/columns in the gallery
case.gallery.row_gap = 3
case.gallery.column_gap = 3
# width,height to allow for file info in gallery table cell

case.gallery.info_height = 150
case.gallery.info_width = 150
# HTML font sizes to use for info in gallery table cell
case.gallery.info_fontsize = 1
case.gallery.info_filename_fontsize = 4
# number of columns in gallery
case.gallery.entries_per_row = 3
# Number of entries per row

# The karyotype specific fields to be display in the gallery
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# These have to be defined in the dem.fields!
case.gallery.fields = firstName,lastName,analysisNum,karyotype_status,slideNum

# The number of digits used in the number portion of an acquired image
# Note that a value of 0 means that leading zeros are never added.

case.number.minimum_digits = 5

#--- Colour Settings -----------------------------------------------------------
# The colour of the polyline used for cutting
tool.polyline.inprogress.colour = (1.0, 1.0, 0.0)

# Paint Tool colours and transparency (this is the tool used when painting to 
define a region)
# Transparancy (0.0 to 1.0) 0.0 completely transparent, 1.0 completely opaque
painttool.transparency = 0.7
# Colours (red, green, blue) each value from 0.0 to 1.0
painttool.colour.1 = (1.0, 0.5, 0.5)
painttool.colour.2 = (0.5, 1.0, 0.5)
painttool.colour.3 = (0.5, 0.5, 1.0)
painttool.colour.4 = (1.0, 0.5, 1.0)
painttool.colour.5 = (0.5, 1.0, 1.0)
# don't change this
painttool.outlineflatness = 1.0
jointool.brush.colour = (1.0, 0.0, 0.0)
overlaptool.brush.colour = (0.0, 0.0, 1.0)

# Colours used in the metaphase view. (red, green, blue) each value from 0.0 to 1.0
# selected chromosomes (red)
meta.select.outline.colour = (1,0,0)
# included chromosomes (blue)
meta.incl.outline.colour = (0,0,1)
# Don't know where this is used (green)
meta.unk.outline.colour = (0,1,0)
# Clusters & objects not included in karyotype (grey)
meta.cluster.outline.colour = (0.5,0.5,0.5)
# Colour used to outline when auto resolve overlap succeeds (green)
meta.lastoverlap.outline.colour = (0,1,0)
# Colour used to outline when auto resolve overlap fails (yellow)
meta.lastoverlap.fail.outline.colour = (1,1,0) 
#meta.excl.outline.colour = # Unknown
#meta.overlap.outline.colour =  # Unknown
# Choose location to export Metaphase JPEG to
meta.export.choosefolder = true

# Colours used in the karyotype view.
kary.chrom.drag.box.colour = (0.8, 0.4, 0.0)
kary.chrom.drop.box.colour = (1.0, 0.5, 0.0)
# Class label colour (red)
kary.class.label.colour = (1,0,0)
#kary.chrom.rotate.box.colour = #unknown
# Choose location to export Karyotype JPEG to
kary.export.choosefolder = true

#--- Tool Settings -------------------------------------------------------------
# set this to require double-click in the painted overlap object to terminate it
painttool.clickterminate = false

# Join tool settings
# Set true to use paint tool for performing joins
# (else clicking to define a  polygon)
jointool.usepaint = true
# Join brush width
#jointool.brushwidth = 15
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# Overlap tool settings
# Set true to use paint tool for resolving overlaps
# (else clicking to define a polygon)
overlaptool.usepaint = true
# Resolve overlap paint brush width
#overlaptool.brushwidth = 15

# The cut tool can configured as a freehand (click and drag) or as
# a polygon tool (multiple clicks terminated by a double click)
cuttool.dragpaintpolymode = true
# Set true to use free hand cut tool

#--- Prototype Settings --------------------------------------------------------
# threshold aggression popup
threshold.enableAggressionPopup = true

#--- MFISH Settings ------------------------------------------------------------
# MFISH support is a separately purchased module. It will only run if 
# the DS Dongle Database has it enabled for the users hardware key
mfish = true
# Set true to display the MFISH menu
#--- Extras --------------------------------------------------------------------
# extramenuitems.fileMenu = TrainClassifier,EvaluateClassifier
# com.apple.mrj.application.stdout=$CONSOLE
# com.apple.mrj.application.stderr=$CONSOLE
# extramenuitems.fileMenu = FindLurkers

#useSwingFileChooser = true

# Specify whether the "Open Multiple Planes..." menu item should be included 
allow.open.multiple = true

#--- Debug Information ---------------------------------------------------------
# debug.level can be SEVERE, WARNING, INFO, CONFIG, FINE, FINER, FINEST, ALL
debug.level=INFO
# Specify a file for dubug output. Leave undefined avoid creating log file.
# debug.logfile can contain the following patterns:
#    "/" the local pathname separator
#    "%t" the system temporary directory
#    "%h" the value of the "user.home" system property
#    "%g" the generation number to distinguish rotated logs
#    "%u" a unique number to resolve conflicts
#    "%%" translates to a single percent sign "%"
debug.logfile=%h/SmartType.log

The SmartType_Prefs.properties File
During the course of using SmartType some settings that you choose (from the menus and dialogs) are 
recorded in the karyotype document. For example if you select Centromeres for the View menu, to 
display the centromere markers in the karyotype view, this setting will be remembered. If you close the 
karyotype document and then reopen the document, you will find that the centromere markers will still be 
displayed. You can set a default value for these settings which gets used when you create a new karyotype 
document. You do this by making you setting choice when no karyotype document is open. These default 
settings are recorded by SmartType in the “SmartType_Prefs.properties” file. This file is stored in the 
following location:

· For Apple Mac users:<user home>/Library/Application Support/SmartType/

· For Windows users: <user home>/ 

Where <user home> refers to the users home directory.
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Known Bugs & Limitations
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EC Declaration of Conformity
SmartType  (Software for the production of Karyotype from 
Metaphase Images) complies with the requirements of the In 
Vitro Diagnostic Medical Devices Directive 98/79/EC. 
Compliance has been demonstrated by an assessment with 
respect to the essential requirements set out in Annex I of 
Directive. The manufacturer retains technical documentation for 
the product which fulfills the requirements set out in Annex III, 
section 3 of Directive 98/79/EC. Any modifications to the 
software may affect the compliance with the directive and 
referenced standards. 

38 Howes Avenue
Thurston

Bury St Edmunds
IP31 3PY

United Kingdom
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